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1 Planning for the HP StoreVirtual VSA
HP StoreVirtual VSA software is a Virtual Storage Appliance that provides complete array
functionality of HP StoreVirtual 4000 Storage for VMware vSphere or Microsoft Hyper-V
environments without external array hardware. The HP StoreVirtual VSA uses scale-out, distributed
clustering to provide a pool of storage with enterprise storage features and simple management.
Multiple StoreVirtual VSAs running on multiple servers create a scalable pool of storage with the
ability to make data highly available.
Beginning with Version 11.0, StoreVirtual VSAs are Adaptive Optimization-capable and can use
multiple tiers of storage. Adaptive Optimization stores data which is accessed most frequently on
the fastest performing media in a storage system—typically solid state drives. Adaptive Optimization
in HP StoreVirtual automatically adapts to changing workloads and moves data accordingly and
transparently. After Adaptive Optimization is enabled, the LeftHand OS stores the most accessed
data to faster/higher tiers in the Adaptive Optimization-capable storage tier.

Figure 1 Example of software-defined storage on HP ProLiant servers with the StoreVirtual VSA

Careful planning of the virtual network configuration, the StoreVirtual VSA configuration, and the
configuration of the HP StoreVirtual management groups, clusters and volumes for data storage
ensures that you can take full advantage of the features and benefits of the HP StoreVirtual Storage.

Planning the virtual network configuration
Before you install the StoreVirtual VSA on the network, plan the virtual network configuration,
including the following areas:

• Design and configuration of the virtual switches and network adapters

• Host names and IP addresses for StoreVirtual VSAs

• Virtual network configuration, including the virtual IP address (VIP) of the StoreVirtual cluster
for iSCSI access

Designing your virtual storage pool
The design of your virtual storage pool affects both its performance and its reliability for production
use. Use the concepts and practices in this manual when installing and managing your virtual
storage pool to ensure optimal performance and reliability.
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Configuration requirements
The following configuration requirements are prerequisites for HP to support your virtual storage
pool for production use.

• Available drive space of up to 32 GB for StoreVirtual VSA plus up to 50 TB of storage which
should be virtualized. HP recommends installing vSphere Server or Hyper-V Server on top of
a redundant RAID configuration. Do not use RAID 0.

• Sufficient number of CPUs reserved for the StoreVirtual VSA capacity, as listed in Table 1
(page 5). Ensure that you have additional memory and additional processors allocated for
any other hosted VMs on the same system.

Table 1 Number of CPUs required by VSA capacity

Reserve CPUsNumber of TB

20 to 10

310 to 20

420 to 35

535 to 50

• Reserved memory based on total disk capacity, as listed in Table 3 (page 6).

IMPORTANT: There are increased memory requirements for the StoreVirtual VSA in Version
11.x, as listed in Table 3 (page 6). Make sure that you increase the memory in existing
StoreVirtual VSAs before performing an upgrade.
Upgrading existing StoreVirtual VSAs also requires that the disks are configured to be persistent.
If the disks are not configured to be persistent, follow the instructions in “Troubleshooting the
StoreVirtual VSA for vSphere” (page 16) to enable the persistent disk identifiers for each disk
before upgrading.

Plan the capacity and duration you intend to configure on the StoreVirtual VSA. The StoreVirtual
VSA requires a license for the capacity and the duration for use beyond the 60–day evaluation
period. Licenses are available in the capacities and durations listed in Table 2 (page 5),
two of which apply to tiered storage on the StoreVirtual VSA.

Table 2 StoreVirtual VSA license capacity

Adaptive OptimizationMaximum cluster sizeDurationMaximum capacity

No33 years
To extend the promotionally
licensed 1 TB VSA, you must

1 TB

upgrade the capacity as well as
extend the duration.

No34 TB ◦ 3 years

◦ 5 years

YesUnlimited10 TB ◦ 3 years

◦ 5 years

YesUnlimited50 TB ◦ 3 years

◦ 5 years
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Table 3 Memory requirements for StoreVirtual VSA disks

Total AO memory requirement in GBTotal memory requirement in GBTotal virtualized capacity

44<= 500 MB

55500 MB – 4 TB

874 TB – 10 TB

12910 TB – 20 TB

171220 TB – 30 TB

211530 TB – 40 TB

261840 TB – 50 TB

• Virtual network environment with 1 GbE connectivity or higher, including the following:

A host name for the StoreVirtual VSA.◦
◦ A network configuration plan, including reserved IP addresses, subnet mask, and gateway

for the StoreVirtual VSA. If you use DHCP, be sure to reserve statically assigned IP
addresses for all storage systems on the DHCP server. Reserved IP addresses are required.

• Dedicated RAID set for StoreVirtual VSA.

• If you plan to use tiered storage for Adaptive Optimization, plan the configuration of the
datastore and physical disks in preparation for installing and configuring the tiered storage
on the StoreVirtual VSA.

IMPORTANT: In the StoreVirtual VSA, Tier 0 designates the fastest storage media. Tier 1
designates the next tier down in speed.

• The minimum configuration for high availability with automatic failover consists of two or more
StoreVirtual VSAs on separate physical servers with Network RAID-10 and a Failover Manager.
A manual failover configuration can be achieved with two or more StoreVirtual VSAs on
separate physical servers and clustered with a Virtual Manager.

See “Configuration requirements for the StoreVirtual VSA for vSphere” (page 11) for configuration
requirements specific to the StoreVirtual VSA for vSphere.
See “Configuration requirements for the StoreVirtual VSA for Hyper-V” (page 18) for configuration
requirements specific to the StoreVirtual VSA for Hyper-V.

Best practices for configuring the StoreVirtual VSA
Other configuration recommendations are useful to improve the reliability and performance of your
virtual storage pool. Consider implementing as many of these best practices as possible in your
virtual storage pool environment.

• Disable drive write caches on systems that are running the StoreVirtual VSA to prevent data
loss in the event of a power failure.

• Each StoreVirtual VSA should meet the following conditions, if possible.

• Have a virtual switch or virtual network comprised of dual Gigabit Ethernet or more. Providing
network redundancy and greater bandwidth improves both performance and reliability.

• Use redundant RAID for the underlying storage of a StoreVirtual VSA in each server to prevent
single disk failures from causing StoreVirtual VSA system failure. Do not use RAID 0.

NOTE: See the HP StoreVirtual Storage User Guide for detailed information about using
RAID for individual storage system data protection.
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See “Best practices for StoreVirtual VSA for vSphere” (page 12) for best practices specific to the
StoreVirtual VSA for vSphere.
See “Best practices for StoreVirtual VSA for Hyper-V” (page 19) for best practices specific to the
StoreVirtual VSA for Hyper-V.

Unsupported configurations for the StoreVirtual VSA
• The StoreVirtual VSA does not support bonding virtual network interfaces.

NOTE: Only the StoreVirtual VSA for vSphere is configured with two network interfaces.
The StoreVirtual VSA for Hyper-V is configured with one network interface.

• The virtual NICs on the StoreVirtual VSA do not support flow control setting modifications or
TCP off-load. The physical NICs on the host server can be configured with these features. (NIC
bonding is a best practice in the host server.)

• The hot removal of virtual hard disks is not supported. See the Microsoft Linux Integration
Services User Guide.

See “Unsupported configurations for StoreVirtual VSA for vSphere” (page 12) for unsupported
configurations specific to the StoreVirtual VSA for vSphere.
See “Unsupported configurations for StoreVirtual VSA for Hyper-V” (page 19) for unsupported
configurations specific to the StoreVirtual VSA for Hyper-V.

Hardware and network design for the StoreVirtual VSA
The hardware platform and network design used for a virtual storage pool affect the capacity,
performance, and reliability of that virtual storage pool. Some hardware platform requirements
are described in “Configuration requirements” (page 5). Other considerations for planning a
StoreVirtual VSA implementation are descrbed below.

• Virtual switch or network

• Controllers and hard disk drives

• Network adapters

Virtual switch or network
The virtual switch or network should be dedicated to the StoreVirtual VSA and iSCSI initiators that
are accessing the StoreVirtual cluster.
The virtual switch or virtual network that is used for StoreVirtual VSA should be at least a redundant
Gigabit network, if possible. Performance and reliability can be improved even further by using
more than two ethernet adapters in the iSCSI and StoreVirtual VSA virtual networks or by using
10 GbE network adapters.

Controllers and drives
The internal disk controller and disk drives of a platform affect the capacity and I/O performance
of the StoreVirtual VSA. Ideally, StoreVirtual VSAs should use storage that is hosted by many drives.
If you are designing a new server that will host StoreVirtual VSAs, you should incorporate the
following recommendations.

• When using hard drives, use as many drives as the platform will allow and that have faster
rotation speeds. The more hard drives and the faster their rotation speed, the more IOPs, and
better performance.

• If using Adaptive Optimization, use SSD drives for ten percent of the storage capacity.

• Select controllers with protected write cache and ensure that the write cache is enabled.
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• Do not enable disk caching on servers that host VSAs.

• Every virtual disk should be RAID-protected and not configured with RAID 0.

Network adapters
The number of network adapters available in a platform affects your options for configuring virtual
switches. StoreVirtual VSAs that will have a dedicated server platform only need two ethernet
(minimum 1 GbE) network adapters. Platforms that will host StoreVirtual VSAs and other virtual
machines should have at least four ethernet (minimum 1 GbE) network adapters so that two adapters
can be dedicated to the StoreVirtual VSA and iSCSI traffic.

Using StoreVirtual VSAs and HP StoreVirtual 4000 Storage
StoreVirtual VSAs and physical storage systems can be mixed in management groups. When
mixing virtual and physical storage systems, and mixing differently configured StoreVirtual VSAs,
consider the following requirements and guidelines.

• Running managers on physical platforms
When possible, locate all managers in a management group on physical platforms instead
of StoreVirtual VSAs, and ideally on the fastest platforms in the management group. While
StoreVirtual VSAs can run managers, physical platforms provide better performance and a
lower likelihood that they will be rebooted for administration reasons.

• Installing StoreVirtual VSAs that are running managers on separate physical platforms
If StoreVirtual VSAs are running managers, ensure that those StoreVirtual VSAs reside on
separate physical platforms. Otherwise, rebooting a single physical platform could cause a
loss of quorum in the management group.

• Managing the performance impact of mixing platforms in clusters
Mixing StoreVirtual VSAs built from different hardware in the same cluster also yields
unpredictable performance. Typically, the overall performance of the cluster is close to the
aggregate average of the storage systems in the cluster.
Additionally, you may perceive performance degradation if a faster StoreVirtual VSA fails,
thereby causing volumes to fail over to a slower StoreVirtual VSA. Such performance
degradation is normal in a mixed cluster.

• Managing the storage capacity of mixing platforms in clusters
While clusters can contain storage systems with different capacities, all storage systems in a
cluster operate at a capacity equal to that of the smallest-capacity storage system. The additional
capacity on the StoreVirtual VSA will operate according the same rules for physical storage
systems in a cluster; that is, the StoreVirtual VSA will operate at a capacity equal to that of
the smallest capacity StoreVirtual VSA in the cluster. See “Clusters and storage systems” in
the HP StoreVirtual Storage User Guide for more information.

Sample configurations
The sample configurations illustrate some of the recommended best practices for redundancy and
availability.

8 Planning for the HP StoreVirtual VSA



Two-storage system configuration
A two-system configuration is the smallest possible redundant configuration. Automatic failover
between storage systems requires a Failover Manager. A two-storage system configuration contains
the following elements.

• Two StoreVirtual VSAs in a single management group

• A single cluster

• Two managers

• A Failover Manager added to the management group

NOTE: For more information, see “Failover Manager Overview” in the HP StoreVirtual
Storage User Guide, available on the following website:

http://www.hp.com/support/StoreVirtualManuals

Figure 2 Two-storage system configuration

Three-storage system-plus configuration
All configurations greater than two storage systems can be redundant, and do not require a Virtual
Manager or Failover Manager. A configuration greater than two storage systems contains the
following elements.

• Three or more storage systems in a management group

• Multiple clusters with as many StoreVirtual VSAs as desired in each cluster

• Running three or five managers, as appropriate

Sample configurations 9
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Figure 3 Three-storage system-plus configuration

Technical videos
Videos are available that illustrate installing the StoreVirtual VSA.

• Overview of the StoreVirtual VSA Install & Config Series
http://h20621.www2.hp.com/video-gallery/us/en/products/storage/
3653680714001/hp-storevirtual-vsa-installation--configuration-1-series-overview/
video/

• StoreVirtual VSA Technology Brief, Licensing and Downloading the Software
http://h20621.www2.hp.com/video-gallery/us/en/products/storage/
3653680718001/
hp-storevirtual-vsa-installation--configuration-2-technology-brief-licensing-and-download/
video/

• Installing StoreVirtual VSA for VMware
http://h20621.www2.hp.com/video-gallery/us/en/products/storage/
3653680719001/
hp-storevirtual-vsa-installation--configuration-3-installing-vsa-for-vmware/video/

• Activating the StoreVirtual VSA 1TB License for VMware & Hyper-V
http://h20621.www2.hp.com/video-gallery/us/en/products/storage/
3653680716001/
hp-storevirtual-vsa-installation--configuration-5-configuring-vsa-for-vmware/video/

• Configuring StoreVirtual VSA for VMware
http://h20621.www2.hp.com/video-gallery/us/en/products/storage/
3653680716001/
hp-storevirtual-vsa-installation--configuration-5-configuring-vsa-for-vmware/video/

• Adaptive Optimization Overview and VMware Deployment
http://h20621.www2.hp.com/video-gallery/us/en/products/storage/
3653680715001/
hp-storevirtual-vsa-installation--configuration-6-adaptive-optimization-overview/video/
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2 Installing the HP StoreVirtual VSA for vSphere
The HP StoreVirtual VSA for vSphere is pre-formatted for use with VMware vSphere. If you are
using an evaluation copy, and want to continue using the fully-featured StoreVirtual VSA after the
trial period has ended, you must purchase a license key. After you apply the license key, your
configuration can be used as is in a production environment, or reconfigured if necessary.

Supported versions of VMware
VMware vSphere 5 for LeftHand OS 9.5 or later.

Configuration requirements for the StoreVirtual VSA for vSphere
• A qualified server for VMware. For a list of qualified servers, see the VMware compatibility

guide, located at:
http://www.vmware.com/resources/compatibility/search.php.

• Virtual disk(s) with up to 2 TB (2047 GB for vSphere 5.0 and vSphere 5.1) or up to 64 TB
(for vSphere 5.5) of space per disk located on internal disk storage, or any block storage that
is on the VMware HCL: internal, external and shared. (Note that the LeftHand OS software
consumes a small amount of the available space.)

• StoreVirtual VSA for vSphere virtual disks must be configured as independent and persistent
to prevent VM snapshots from affecting them.

• The VMFS datastores for the StoreVirtual VSA must not be shared with any other VMs.

• Microsoft .Net 3.5 on the installer client.

• vCenter servers properly licensed before connecting to them using the HP StoreVirtual VSA
for vSphere installer.

• When installing VSAs that use more than 8 TB of datastores, increase the VMFS heap size.
According to VMware, the VMFS heap size must be increased to access more than 8 TB of
VMDKs in a VM. This means that a StoreVirtual VSA that uses more than 8 TB of datastores
should have the heap size increased. See the following article for more information:
http://kb.vmware.com/kb/1004424
The default heap size has been increased in vSphere 5.x to 80 MB, which allows for 8 TB of
open virtual disk capacity on a single vSphere host.

NOTE: In vSphere 5.x the maximum heap size is 256 MB. This allows for a maximum of
25 TB of open storage.

Table 4 (page 11) outlines the minimum and maximum heap sizes that can be set for the
various builds of vSphere:

Table 4 Minimum and maximum heap sizes

Maximum open VMDK
storage per hostMaximum heap valueMinimum heap valueVersion/build

32 TB128 MBN/AESXi/ESX 4.x

25 TB256 MBN/AESXi 5.0 Build 914586
and earlier

60 TB640 MB256 MBESXi 5.0 Build 1024429
and later

Supported versions of VMware 11

http://www.vmware.com/resources/compatibility/search.php
http://kb.vmware.com/kb/1004424


Table 4 Minimum and maximum heap sizes (continued)

Maximum open VMDK
storage per hostMaximum heap valueMinimum heap valueVersion/build

25 TB256 MBN/AESXi 5.1 Build 914609
and earlier

60 TB640 MB256 MBESXi 5.1 Build 1065491
and later

Best practices for StoreVirtual VSA for vSphere
• Configure the StoreVirtual VSA for vSphere to start automatically and first, and before any

other virtual machines, when the vSphere Server on which it resides is started. This ensures
that the StoreVirtual VSA for vSphere is brought back online as soon as possible to automatically
re-join its cluster.

• Locate the StoreVirtual VSA for vSphere on the same virtual switch as the VMkernel network
used for iSCSI traffic. This allows for a portion of iSCSI I/O to be served directly from the
StoreVirtual VSA for vSphere to the iSCSI initiator without using a physical network.

• Locate the StoreVirtual VSA for vSphere on a virtual switch that is separate from the VMkernel
network used for VMotion. This prevents VMotion traffic and StoreVirtual VSA for vSphere
I/O traffic from interfering with each other and affecting performance.

• HP recommends installing vSphere Server on top of a redundant RAID configuration with a
RAID controller that has battery-backed cache enabled. Do not use RAID 0.

Unsupported configurations for StoreVirtual VSA for vSphere
• Use of VMware snapshots, VMotion, High-Availability, Fault Tolerance, or Distributed Resource

Scheduler (DRS) on the StoreVirtual VSA for vSphere itself.
• Use of any vSphere Server configuration that VMware does not support.

• Extending the data virtual disk(s), vSphere Server SCSI 1:x, of the StoreVirtual VSA for vSphere
while in a cluster. Create additional disks and hot-add them instead. See “Adding storage
capacity to a StoreVirtual VSA” (page 24).

• Co-location of a StoreVirtual VSA for vSphere and other virtual machines on the same physical
platform without reservations for the StoreVirtual VSA for vSphere CPUs and memory in
vSphere.

• Co-location of a StoreVirtual VSA for vSphere and other virtual machines on the same VMFS
datastore.

• Running StoreVirtual VSA for vSphere’s on top of existing HP StoreVirtual Storage is not
recommended.

Installing the HP StoreVirtual VSA for vSphere
Download and install the StoreVirtual StoreVirtual VSA for vSphere from the HP website:

www.hp.com/go/StoreVirtualDownloads

The installer for the StoreVirtual VSA for vSphere includes a wizard that guides you through
configuring the virtual machine on the network, configuring virtual or physical hard drives, and
powering on the StoreVirtual VSA. The installer checks for the current HP StoreVirtual Centralized
Management Console, and then installs it, if it is not on the system. (For instructions about installing
the StoreVirtual StoreVirtual VSA for vSphere OVF version, see “Installing the StoreVirtual VSA
OVF version” (page 14).)
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NOTE:
• If a prior version CMC is installed on a management computer on the network, the StoreVirtual

VSA for vSphere installer updates the CMC to the current version in the same location. The
user-specified location entered in the installer wizard is ignored.

After the installation is complete, open the CMC and find the StoreVirtual VSAs as storage systems
in the CMC. You can then set up the clustered storage for the SAN, as described in “Getting started
with HP StoreVirtual Storage” (page 22).

Table 5 Configuring the StoreVirtual VSA for vSphere using the installer wizard

DefinitionInstaller step

vCenter Server that will host the StoreVirtual VSA. Enter either the IP address or host name of the
server.

Host Setup

List of vSphere hosts managed by the vCenter Server or single vSphere Server, and health status
and configuration details for the host. Select the host the StoreVirtual VSA should be deployed to.
If deploying more than one StoreVirtual VSA, you can chose to do so at the end of the wizard.

Select Host

The type of virtual machine to install. Choices include the StoreVirtual VSA or the Failover Manager
(FOM). The Virtual Storage Appliance (StoreVirtual VSA) is the storage system. The Failover

Type

Manager is a specialized version of the LeftHand OS software designed to operate as a manager
and provide automated failover capability. See the HP StoreVirtual Storage User Guide for
information about installing the Failover Manager (Failover Manager).
If choosing the StoreVirtual VSA, you can also choose whether the StoreVirtual VSA should be
Adaptive Optimization-capable and use multiple tiers of storage.

List of datastores available on the host. Select the desired datastore to store the virtual appliance
files.

Datastore

Network settings include the following information:Network
• DNS name for the StoreVirtual VSA. The name for the StoreVirtual VSA must be 80 characters

or less. Valid characters include a-z (case insensitive), 0–9, and –.
• NIC to configure. Available NICs are eth0 and eth1. The StoreVirtual VSA for vSphere can

support up to two NICs.

◦ IP address
A reserved IP address is recommended. Enter the IP address, subnet mask, and gateway.
DHCP is supported. If you use DHCP, be sure to reserve statically assigned IP addresses for
all storage systems on the DHCP server.

◦ The virtual network designated for the StoreVirtual VSA. Select the appropriate virtual network
from the list.

• The NIC designated as the preferred interface for LeftHand OS, which is used for cluster
communication and iSCSI host traffic. Select eth0 or eth1.

Information for creating the virtual machine, including the following:Virtual Machine
• Name for the virtual machine in (as it should appear in the VM inventory on the host or vCenter)

• Type of drive mapping to storage which should be virtualized by the StoreVirtual VSA — Virtual
Machine Disk Format (VMDK) or Raw Device Mapping (RDM)

Virtual or raw drive requirementsVMDK or Raw
Disk • Maximum of 7 drives

• Minimum size: 5 GB

• Maximum size: 2047 GB in vSphere 5.0 or 5.1; 64 TB in vSphere 5.5

Depending on which type of mapping was selected in the previous step, the wizard opens one
of the following windows:
Virtual hard drives window
Select up to 7 virtual hard drives and designate the size.
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Table 5 Configuring the StoreVirtual VSA for vSphere using the installer wizard (continued)

DefinitionInstaller step

If configuring tiered storage, assign a tier to each drive. Tier 0 is the fastest tier.
Raw Disk window
Select up to 7 raw disks that you have prepared, and which are available. These drives must have
no partitions or volumes on them, or the installer will not list them.
If configuring tiered storage, assign a tier to each drive. Tier 0 is the fastest tier.

IMPORTANT:
• The raw disk size can be greater than 2 TB in VMware. However, the total amount of configured

storage on the StoreVirtual VSA cannot exceed 50 TB or the RAID Stripe configuration will fail.
• Be sure to plan the disk capacity in conjunction with the licensing for the StoreVirtual VSA.

Storage capacity can be added but not removed. The purchased license controls the amount
of storage that can be used regardless of the disk capacity. See Table 2 (page 5).

• Every virtual disk should be RAID-protected and not configured with RAID 0. The RAID Stripe
that is configured on the StoreVirtual VSA operates like RAID 0, and creates a pool of storage
that has no redundancy across the drives.

1. Double-click the downloaded executable to start the installation.
2. Click Install VSA for VMware vSphere to begin the wizard.
3. In the command line window that opens, enter 1 to run the installer CLI, or enter 2 to run the

installer GUI. Both versions require the same information and perform the same installation.

NOTE: If you selected the GUI installation, the GUI installer window opens again and you
click Install VSA for VMware for vSphere again to begin the wizard.

4. If necessary, enter the login credentials to allow the installer to configure the StoreVirtual VSA
for vSphere on the vSphere server, and click Yes.

5. Accept the terms of the License Agreement again.
6. Work through the wizard to configure the parameters of the virtual machine on the network,

including the hard drives. See Table 5 (page 13).
7. (Optional) Configure another StoreVirtual VSA for vSphere using the same parameters as

appropriate.
8. Finish the installation, reviewing the configuration summary, and click Deploy.

When the installer is finished, the StoreVirtual VSA for vSphere should be started on the
vSphere hosts and should be discoverable in the CMC.

9. Use the Find function in the CMC to discover the StoreVirtual VSA for vSphere, and then add
it to a management group.

Installing the StoreVirtual VSA OVF version
Import the StoreVirtual StoreVirtual VSA for vSphere OVF version as a virtual appliance through
the Virtual Infrastructure Client.
1. Download the .ovf zip file from the website:

http://www.hp.com/go/StoreVirtualDownloads

2. Unzip the files.
3. Reserve the memory for the StoreVirtual VSA. See “Memory requirements for StoreVirtual VSA

disks” (page 6) for memory requirements for StoreVirtual VSA disks.

Configuring a data disk
1. In the vSphere Client, navigate to the Inventory Panel.
2. Click Add at the bottom of the Hardware tab.
3. Select Hard Disk as the type of device to add and click Next.
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4. Select Create a new virtual disk and click Next.
5. In the Disk Capacity section, designate a capacity that is suitable for the amount of storage

available on your vSphere Server.
6. In the Location section, select Store with Virtual Machine, and click Next.
7. For the first disk, select the Virtual Device Node to be SCSI 1:0 from the list. For additional

disks, assign SCSI 1:1 through 1:6, in sequential order.

CAUTION: Selecting anything other than SCSI 1:0 for the first disk causes RAID to be
unconfigurable later.

8. Select Mode→Independent→Persistent and click Next.
9. Review the device configuration and click Finish.

Powering on the StoreVirtual VSA for vSphere and setting the IP address and
host name
1. In the inventory panel, select the new StoreVirtual VSA for vSphere and power it on.
2. Select the Console tab and wait for the StoreVirtual VSA for vSphere to boot.
3. When the StoreVirtual VSA for vSphere finishes booting, enter Start and press Enter to log in

to the Configuration Interface.
4. On the Configuration Interface main menu, press Tab to select Network TCP/IP Settings and

press Enter.
5. On the Available Network Devices window, press Tab to select the applicable network interface

and press Enter.
6. On the Network Settings window, press Tab to select the Hostname box and enter a host

name for the StoreVirtual VSA. Use backspace to erase an entry if necessary.
This host name displays in the CMC only. It does not change the name of the original .vmx
file or the name of the virtual machine in the VMware interface.

7. Press Tab to select the method for setting the IP address.
If you are entering a static IP address, note that Gateway is a required field. If you do not
have a gateway, enter 0.0.0.0.

8. Press Tab to select OK and press Enter.
9. Press Enter again to confirm the action.
10. After the settings are configured, press Enter to confirm the IP address change.
11. On the Available Network Devices window, press Tab to select Back and press Enter.
12. On the Configuration Interface, press Tab to select Log Out and press Enter.

Verifying the IP address and host name
1. In the vSphere Client Information Panel, select the Summary tab.
2. In the General section on the Summary tab, verify that the IP address and host name are

correct, and that VMware Tools are running.

NOTE: If VMware Tools show out of date or Unmanaged, then they are running correctly.
These statuses are not a problem, because the tools are available and running. VMware tools
are updated with each LeftHand OS software upgrade.
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Troubleshooting the StoreVirtual VSA for vSphere
Table 6 Troubleshooting the StoreVirtual VSA for vSphere

SolutionProblem

You want to reinstall the StoreVirtual VSA. 1. Close your CMC session.
2. In the vSphere Client, power off the StoreVirtual VSA.
3. Right-click and select Delete from Disk.
4. Copy fresh files into the virtual machine folder from the

downloaded .zip file.
5. Open VMware and begin again.

In the VMware Console, open the Configuration Interface.
Navigate to the Network Settings window to verify the IP
address.

You cannot find the HP StoreVirtual VSA for vSphere with
the CMC, and cannot recall its IP address.

Verify that the HP StoreVirtual VSA for vSphere has a virtual
disk configured on SCSI 1:0. StoreVirtual VSAs use SCSI

You cannot configure RAID.

0:0 for operating system disks. They use the disk configured
for SCSI 1:0 for SAN data storage. If no SCSI disk is
configured for SCSI 1:0 then RAID cannot be configured
on the appliance.

The best practice is to use a unique name for each instance
of the StoreVirtual VSA that you create.

You cannot run concurrent StoreVirtual VSA Installers and
use the same name for the StoreVirtual VSAs on the same
host you are creating.

Follow these steps to enable the persistent disk identifiers
for each HP StoreVirtual VSA for vSphere:

LeftHand OS upgrades fail because persistent disk
identifiers are not enabled.

1. From the CMC, power off the StoreVirtual VSA.
2. Open the VMware vSphere Client, and log into a

vCenter Server or ESX Server.
3. Verify that the virtual machine is powered off.
4. Right-click the virtual machine and select Edit Settings.
5. Click the Options tab and select the General entry in

the settings column (under the Advanced entry).
6. Click Configuration Parameters.
7. Click Add Row.
8. In the Name column, enter disk.Enable UUID.
9. In the Value column, enter True.
10.Click OK and then click Save.
11. Power on the virtual machine in the vSphere Client.

In Windows

Reset the Hardware Acceleration in Windows:The Installation wizard freezes.
1. Open the Windows Display Settings→Advanced

settings→Troubleshoot tab.
2. Move the Hardware Acceleration slider to one notch

above None.
3. Click OK twice to exit the Properties dialog.
4. Restart the Installation wizard.

In Linux

Run CMC_Installer.bin again.The installer does not start automatically.

In vSphere Client
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Table 6 Troubleshooting the StoreVirtual VSA for vSphere (continued)

SolutionProblem

If your cursor is missing, you are in console mode. Press
Ctrl-Alt to regain the cursor. If your keyboard is missing,
move the mouse to the console window and click once.

Mouse and keyboard are not responding or are "trapped"
in the StoreVirtual VSA.

You want to see your HP StoreVirtual VSA for vSphere, but
the window is black.

• You are in the Console view of the guest window.
Change to the Summary view.

• Your Console window has timed out. Click in the
window with the mouse and then press Backspace.
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3 Installing the HP StoreVirtual VSA for Hyper-V
The HP StoreVirtual VSA for Hyper-V is pre-formatted for use with Microsoft® Windows® Server.
Install the StoreVirtual VSA for Hyper-V on a Windows server configured with redundant RAID. If
you are using an evaluation copy and want to continue using the fully-featured StoreVirtual VSA
for Hyper-V after the trial period has ended, you must purchase a license key. After you apply the
license key, your configuration can be used as is in a production environment, or reconfigured if
necessary.

Supported versions of Microsoft Windows Server
All operating systems listed are 64–bit. HP StoreVirtual VSA for Hyper-V is supported on 64–bit
systems only.

• Windows Server 2012

• Windows Server 2012 R2

• Microsoft Hyper-V Server 2008 R2

• Windows Server 2008 R2 Standard

• Windows Server 2008 R2 Enterprise

• Windows Server 2008 R2 Datacenter

• Windows Server 2008 R2 Server Core

• Windows Server 2008 SP2, except for Core, which is not supported

• Core and Full installation are supported on Windows Server 2008 R2 and later

Configuration requirements for the StoreVirtual VSA for Hyper-V
• A qualified server for Microsoft Hyper-V.

To verify the server is listed and qualified for Hyper-V Server, go to http://
windowsservercatalog.com/results.aspx?&bCatID=1283&cpID=0&avc=11&ava=0&OR=1&
PGS=25, and then search for “Hyper-V” as an additional qualification. See the supported
Windows versions.

• Virtual disk(s) with 5GB to 50TB (up to 50TB for Windows Server 2012 and higher; up to
2TB for Windows Server 2008 R2 and prior) of space per disk located on internal disk storage,
or direct attached storage that is not accessible from more than one physical server. (Note
that the LeftHand OS software consumes a small amount of the available space.)

• StoreVirtual VSA for Hyper-V virtual disks must be fixed, not dynamic.

• Microsoft .NET 3.5 on the installer client

• The NTFS partition for the StoreVirtual VSA must not be shared with any other VMs.

• Define the install paths for the Hyper-V virtual machine and the virtual hard disks.
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• On Windows Server 2008 R2, ensure the following hotfixes are applied before beginning
the installation: KB 979711, KB 975530, KB 981836. See the following Microsoft
KnowledgeBase articles:

◦ http://support.microsoft.com/kb/979711

◦ http://support.microsoft.com/kb/975530

◦ http://support.microsoft.com/kb/981836

• If using physical disks for the StoreVirtual VSA for Hyper-V, ensure that:

The disks are completely clean of any partitions or any other remnants prior to running
the StoreVirtual VSA for Hyper-V installer.

◦

◦ The disks are connected, but offline in Windows Disk Manager before starting the installer.

Best practices for StoreVirtual VSA for Hyper-V
• Configure the StoreVirtual VSA for Hyper-V to start automatically and first, and before any

other virtual machines. The default installation configuration for the StoreVirtual VSA for Hyper-V
is set to automatically start if it was running when the server shut down.

• For the StoreVirtual VSA for Hyper-V, dedicate a virtual network for iSCSI traffic.

• HP recommends installing Hyper-V Server on top of a redundant RAID configuration with a
RAID controller that has battery-backed cache enabled. Do not use RAID 0.

Unsupported configurations for StoreVirtual VSA for Hyper-V
• Use of Microsoft Live Migration, Quick Migration, or snapshots on the StoreVirtual VSA itself.

• Use of any Hyper-V Server configuration that Microsoft does not support.

• Extending the data virtual disk(s), the first SCSI Controller in Hyper-V, of the StoreVirtual VSA
while in a cluster. Create additional disks and hot-add them instead. See “Adding storage
capacity to a StoreVirtual VSA” (page 24).

• Co-location of a StoreVirtual VSA and other virtual machines on the same NTFS partition.

• Running StoreVirtual VSA for Hyper-Vs on top of existing HP StoreVirtual Storage is not
recommended.

Installing the HP StoreVirtual VSA for Hyper-V
Download and install the HP StoreVirtual VSA for Hyper-V from the HP website:

www.hp.com/go/StoreVirtualDownloads

The installer for the StoreVirtual VSA for Hyper-V includes a wizard that guides you through
configuring the virtual machine on the network, configuring virtual or physical hard drives, and
powering on the StoreVirtual VSA for Hyper-V. After finishing the installation, install the CMC and
find the StoreVirtual VSAs as storage systems in the CMC. You can then set up the clustered storage
for the SAN, as described in “Getting started with HP StoreVirtual Storage” (page 22).

NOTE: One or more Microsoft hotfixes may be required on your system before you can install
the StoreVirtual VSA for Hyper-V. If this is the case, before the installer actually begins, a window
opens that notifies you of the required hotfixes and provides links to the appropriate site to download
the hotfix.
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Table 7 Configuring the StoreVirtual VSA for Hyper-V using the installer wizard

DefinitionInstaller Step

One or more Microsoft hotfixes that must be installed before installing the StoreVirtual VSA for
Hyper-V.

Hotfix required

The type of virtual machine to install. Choices include the StoreVirtual VSA or the Failover Manager
(FOM). The Virtual Storage Appliance (StoreVirtual VSA) is the storage system. The Failover

Type

Manager is a specialized version of the LeftHand OS software designed to operate as a manager
and provide automated failover capability. See the HP StoreVirtual Storage User Guide for
information about installing the Failover Manager (Failover Manager).
If choosing the StoreVirtual VSA, you can also choose whether the StoreVirtual VSA should be
Adaptive Optimization-capable and use multiple tiers of storage.

Locations for the virtual machine and the virtual disks.Destination

Includes the following network information:Network
• Host name for the StoreVirtual VSA for Hyper-V.

• IP address.
Reserved IP address is recommended. DHCP is available. If you use DHCP, be sure to reserve
statically assigned IP addresses for all storage systems on the DHCP server.

• The virtual network designated for the virtual machines. Select the appropriate network from
the list.

NOTE: The installer for the StoreVirtual VSA for Hyper-V only configures one virtual network
interface. However, an additional virtual network interface can be added manually via the virtual
machine settings.

Information for creating the virtual machine, including the following:Virtual machine
• Name for the virtual machine in Hyper-V

• Type of hard drives, virtual or physical

• Check box to power on the StoreVirtual VSA for Hyper-V after it is installed

Virtual or physical drive requirementsHard drives, either
virtual or physical • Maximum of 7 drives

• Minimum size: 5 GB

• Maximum size: 2040 GB or 64 TB in Windows Server 2012

One of two windows opens, depending on which type of drives were selected in the Virtual
machine window.
Virtual hard drives window
Select up to 7 virtual hard drives and designate the size.
If configuring tiered storage, assign a tier to each drive. Tier 0 is the fastest tier.
Physical Drives window
Select up to 7 physical drives that you have prepared, and which are offline. These drives must
have no partitions or volumes on them, or the installer will not list them. To reuse HVSA disks for
expanding storage on a new HVSA, partitions must first be manually deleted.
If configuring tiered storage, assign a tier to each drive. Tier 0 is the fastest tier.

IMPORTANT:
• The total amount of configured storage on the StoreVirtual VSA for Hyper-V cannot exceed 50

TB or RAID Stripe will fail.
• Be sure to plan the disk capacity in conjunction with the licensing for the StoreVirtual VSA.

Storage capacity can be added but not removed. The purchased license controls the amount
of storage that can be used regardless of the disk capacity. See Table 2 (page 5).

• Every virtual disk should be RAID-protected and not configured with RAID 0. The RAID Stripe
that is configured on the StoreVirtual VSA operates like RAID 0, and creates a pool of storage
that has no redundancy across the drives.

1. Double-click the downloaded executable to start the installation.
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2. Accept the terms of the License Agreement.
3. Configure the parameters of the virtual machine on the network, including the hard drives.

See Table 7 (page 20).

NOTE: You can run the wizard again to configure another StoreVirtual VSA for Hyper-V
using the same parameters as appropriate.

4. Finish the installation, reviewing the configuration summary.
When the installer is finished, the StoreVirtual VSA for Hyper-V is ready to be used in HP
StoreVirtual Storage.

5. Next, install the CMC, described in “Getting started with HP StoreVirtual Storage” (page 22).
Then follow the steps in “Installing the CMC” (page 22).
The installer may take a few minutes to complete, depending upon the underlying hardware.

Troubleshooting the StoreVirtual VSA for Hyper-V
Table 8 Troubleshooting the StoreVirtual VSA for Hyper-V

SolutionProblem

While installing the StoreVirtual VSA for Hyper-V, you do
not see the physical disks you prepared.

1. Close the installer.
2. Verify that the disks are offline.
3. Start the installer again.

Do not use an iSCSI volume on a SAN as the physical disk
for a StoreVirtual VSA.

StoreVirtual VSA for Hyper-V reboot fails if the physical
disk of the StoreVirtual VSA for Hyper-V is an iSCSI
mounted volume

Using the Hyper-V Manager:You want to reinstall the StoreVirtual VSA for Hyper-V.
1. Close your CMC session.
2. In the Hyper-V Manager, power off the StoreVirtual VSA

for Hyper-V.
3. Right-click and select Delete from Disk.
4. Optional: Delete the .vhd files to recover the disk

space.
5. Rerun the .exe file and reinstall the StoreVirtual VSA

for Hyper-V.
6. Open the Hyper-V Manager and begin again.

Open the Configuration Interface. Navigate to the Network
Settings window to verify the IP address.

You cannot find the StoreVirtual VSA for Hyper-V with the
CMC, and cannot recall its IP address.
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4 Getting started with HP StoreVirtual Storage
Installing the CMC

Install the CMC on the computer or virtual machine that you use to administer the HP StoreVirtual
Storage. You administer the entire network of StoreVirtual VSAs from this CMC. To obtain the
CMC, download the CMC installer from the following website:

http://www.hp.com/go/StoreVirtualDownloads

The CMC installation requires 63 MB disk space and 64 MB RAM during runtime.

Installing the CMC in Microsoft Windows
1. Start the CMC installer.
2. Follow the steps in the installation wizard.
3. When the installation completes, HP is added as a separate Program Group and a shortcut

icon is added to the Microsoft Windows desktop.
To start the CMC:

• Double-click the icon on your desktop, or

• From the Start menu, select All Programs→HP →HP StoreVirtual→HP StoreVirtual Centralized
Management Console.

Installing the CMC in Linux
You must be running the X Window System to install the application.
1. Click the CMC installer.
2. Follow the steps in the installation wizard.
3. When the installation completes, HP is added as a separate Program Group.
To start the CMC:
From the directory in which you installed the files, run the script ./HP StoreVirtual
Centralized Management Console.

Getting started with the CMC
The CMC is configured to find all StoreVirtual VSA and physical storage systems on the subnets
which the system running the CMC is connected to. The first time you open the CMC, it automatically
finds all the storage systems and they appear in the Navigation pane.
To control which storage systems appear in the CMC, change the configuration using the following
steps.
1. Open the CMC.
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2. Click Find Systems on the Getting Started Launch Pad.
In the Find Systems window, use these features to control the list of storage systems:
• Clear Auto Discover by Broadcast to prevent the entire subnet of storage systems from

appearing in the Navigation pane.
• If your storage systems are on another subnet, add individual IP addresses of storage

systems that you want to appear in the Navigation pane.

Figure 4 Editing Find Systems to control the storage systems displayed

1. Clear Auto Discover by Broadcast

2. Add IP addresses for specific storage systems

Completing the StoreVirtual VSA hardware configuration
When you install the HP StoreVirtual Centralized Management Console, you should configure the
storage system features, such as RAID, bonding the NICs, and setting up email alert notification,
before you configure the data storage.
Complete the hardware configuration before adding the StoreVirtual VSA to a management group.
Select the StoreVirtual VSA in the Navigation pane to expand the hardware configuration categories.
Verify that RAID Stripe is configured. Verify that the network settings are correct.
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Figure 5 Configuring the hardware

1. Configure RAID and the network from these categories

Creating a StoreVirtual cluster
Use the Management Groups, Clusters, and Volumes wizard on the Getting Started Launch Pad
to create your storage pool. The wizard has online help available on each page.

Reviewing the Best Practice Summary
Use the Best Practice Summary on the SAN Status Page in the CMC to review your configuration
and to ensure you are following best practices for the disk RAID and Network RAID configurations,
as well as network configurations and the overall configuration. The Best Practice Summary provides
an easy-to-use reference about best practices that can increase the reliability and performance of
your configurations. Move the mouse over a best practice item to see an explanation of the best
practice.
1. Navigate to the SAN Status Page in the CMC.
2. Log in to the management group to verify the Best Practices for that management group.

Adding storage capacity to a StoreVirtual VSA
Add storage capacity to a StoreVirtual VSA by adding up to 6 additional virtual disks for a total
of 7 disks. Ensure that if you add capacity to a StoreVirtual VSA in a cluster, you balance the
capacity of all the storage systems in the cluster, i.e. all storage systems should have the same
capacity. See “Using StoreVirtual VSAs and HP StoreVirtual 4000 Storage” (page 8) for
information about storage capacity and platforms in a cluster.
The following steps describe how to add disks after the StoreVirtual VSA has been added to a
management group and cluster. However, you can add the disks to the StoreVirtual VSA when
you first configure it, before you use it for clustered storage.

NOTE: When adding new capacity to the StoreVirtual VSA, make sure you have the right license
to accommodate the capacity. See Table 2 (page 5).
If you have upgraded to LeftHand OS version 11.0 from version 9.0, it is necessary to change the
iSCSI controller to a paravirtual adapter to allow for disks to be added while the StoreVirtual VSA
is powered on. To make this change, open the vSphere client on the vSphere server from which
the StoreVirtual VSA is being deployed. Right-click the StoreVirtual VSA and select Edit settings.
Change the adapter type from iSCSI controller to paravirtual adapter.

Creating additional disks
Create up to 6 additional disks for a StoreVirtual VSA. The additional disks can be added to the
StoreVirtual VSA in the CMC, while the StoreVirtual VSA is powered on.
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IMPORTANT: Hot-addition of disks is not supported in VMware configurations where the storage
controller is LSI Logic SCSI. Hot-add is supported on StoreVirtual VSAs which run LeftHand OS
11.0 and higher with Paravirtual SCSI (PVSCSI) adapters.

Requirements
• Minimum disk size—5 GB

• Maximum disk size

2047 GB for vSphere Server 5.0 or 5.1, 64 TB for vSphere Server 5.5◦
◦ 2040 GB for Hyper-V for Windows Server 2008, 64 TB for Hyper-V for Windows Server

2012

• If reusing disks from a different StoreVirtual VSA, you must ensure that there are no partitions
or volumes on those disks.

• Created sequentially as follows:

vSphere Server—from SCSI 1:1 through SCSI 1:6. This assumes that the first disk has
already been created and assigned to SCSI 1:0.

◦

◦ Hyper-V—locations 1 through 6 to SCSI Controller 0. This assumes that the first disk has
already been created in SCSI Controller 0, location 0.

IMPORTANT: If you are adding disks to StoreVirtual VSAs that are already in a cluster, be aware
that the process may take more time and that the CMC does not prevent multiple storage systems
in a cluster from being taken offline. When adding a disk, the storage system is restarted and the
new disk is formatted. The format operation may take a long time to complete if the new disk is
large. New writes are then resynchronized with the other storage systems in the cluster, which can
impact performance. If it is a cluster with a single storage system, the volumes will go offline.
Further, HP recommends that you do not add another new disk until the previous disk addition has
completed. This ensures that there is no loss of quorum. You should also add disks to only one
StoreVirtual VSA at a time. Wait until the first StoreVirtual VSA has finished resynchronizing and
the cluster is healthy before adding disks to another StoreVirtual VSA.

Creating the disk
1. Using either the vSphere Client, or Microsoft Hyper-V Manager, add from 1 to 6 disks to the

StoreVirtual VSA.
2. Assign each disk to the next sequential SCSI address or location.
3. Configure the disks as follows:

• vSphere Server disks as independent and persistent

• Hyper-V disks as fixed size
4. Increase memory based on the total capacity of the StoreVirtual VSA, according to the

requirements in Table 3 (page 6) .

Adding disks to RAID
A new disk appears as Uninitialized in the Disk Setup tab of the Storage configuration category.
Add the new disk to RAID, which automatically powers the disk on.
1. In the CMC, navigate to the StoreVirtual VSA.
2. Select the Storage configuration category and select the Disk Setup tab.
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3. Select the disk to add to RAID.
Disks must be added to RAID sequentially. For example, you cannot add disk 3 to RAID if disk
2 has not been added.

4. Right-click and select Add Disk to RAID.

Documentation available
For detailed instructions about using the CMC and the StoreVirtual VSA, see the following resources.
You can find these documents on the following website:

http://www.hp.com/support/StoreVirtualManuals

• HP StoreVirtual Storage Online Help
All User Guide content is contained in the HP StoreVirtual Storage Online Help, available
from the menu bar under Help→Help Topics. Context sensitive help is available by clicking

the question mark on any window ( ).

• HP StoreVirtual Storage User Guide
The HP StoreVirtual Storage User Guide provides detailed instructions for using the LeftHand
OS software to create, access and manage the clustered data storage.

• HP StoreVirtual Storage Remote Copy User Guide
The HP StoreVirtual Storage Remote Copy User Guide provides instructions for using the
Remote Copy capabilities of the LeftHand OS software.

• HP StoreVirtual Storage Multi-Site Configuration Guide
The HP StoreVirtual Storage Multi-Site Configuration Guide provides instructions for configuring
and using the HP StoreVirtual Multi-Site SAN.
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5 Using the VMware StoreVirtual VSA laptop demo
The StoreVirtual VSA laptop demo is the smallest and most portable version of the LeftHand OS
software virtual appliance. It is intended to demonstrate all the capabilities of HP StoreVirtual
Storage (physical storage appliances as well as StoreVirtual VSA), including storage clustering
and data protection features on VMware Workstation or Player. When using advanced features,
it will run for a limited time of 60 days.

NOTE: There is not a separate demo version of the HP StoreVirtual VSA for Hyper-V Server.

The StoreVirtual VSA laptop demo can be used indefinitely as a single storage system iSCSI target
with snapshots. If a configuration is deleted and recreated, the trial period of licensed features
starts again.
To demo HP StoreVirtual VSA for vSphere, download the time-limited trial version and follow the
instructions in “Installing the HP StoreVirtual VSA for vSphere” (page 11) to set up virtual HP
StoreVirtual Storage. Adding a license removes the time restriction of the trial license.
The laptop demo of the StoreVirtual VSA runs a full-featured version of the LeftHand OS software,
and provides the following capabilities:

• Use of the LeftHand OS software without requiring physical storage devices.

• Use of advanced LeftHand OS software features such as Clustering, Network RAID,
application-managed snapshots, thin provisioning, Remote Copy and Multi-Site SAN.

The demo is available at www.hp.com/go/tryvsa.

Requirements for the demo
• The demo StoreVirtual VSA is supported on 64–bit systems only

• Minimum of 3 GB of RAM

• One virtual CPU with 2 GHz reserved

• A dedicated gigabit virtual switch

• 5 GB to 2 TB of disk space per virtual disk, up to 10 TB total per virtual storage appliance

• VMware Player, Workstation

• IP address, subnet mask, and gateway for the virtual machine

Planning the demo installation
Before you install the StoreVirtual VSA, plan the virtual network configuration.

• Virtual appliance directories, host names and IP addresses – Create a directory for each virtual
machine on the hard drive you will use as the storage system.

• Network configuration – Plan the subnet and IP address for the virtual machines as well as
for the VIPs required for storage clusters.

• Storage configuration – Install the CMC on Linux or Microsoft Windows. Then use the CMC
to find storage systems, create storage, and connect to application servers.

Installing the StoreVirtual VSA
To install the laptop demo of the StoreVirtual VSA, you will:

• Unzip to the prepared directory and start the virtual machine.

• Direct the Ethernet port to NAT (default), Host-only, or bridged.

• Set the IP address and host name of the StoreVirtual VSA.
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You only need to configure each virtual machine once.
1. Copy or download the StoreVirtual VSA .zip file.
2. Copy or unzip the StoreVirtual VSA files to the virtual machine directory.

NOTE: Copy the files to multiple directories for multiple VSAs.

Configuring the StoreVirtual VSA with VMware Player or VMware Workstation
1. Open the VMware console.
2. Click File→Open to open the VSA.vmx file.
3. Navigate to the location of the unzipped StoreVirtual VSA files.
4. Select the VSA.vmx file and click Open.
5. Edit the StoreVirtual VSA settings as required by the VMware console you are using. Select

the appropriate network mode:
• Bridged

• NAT

• Host-only

NOTE: All StoreVirtual VSAs on the same platform should use the same networking mode.
When running multiple StoreVirtual VSAs on a single host, use NAT or Host-only networking
mode, and use DHCP to assign IP addresses to the StoreVirtual VSAs.

6. Power on the StoreVirtual VSA.
7. Use the Configuration Interface to set the IP address and host name as described in “Powering

on the StoreVirtual VSA for vSphere and setting the IP address and host name” (page 15):

Upgrading the StoreVirtual VSA demo
StoreVirtual VSAs that run on VMware Workstation or VMware Player cannot be upgraded.
However, you can download and install the updated version from the HP StoreVirtual downloads
page.
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6 Support and other resources
Contacting HP

For worldwide technical support information, see the HP support website:
http://www.hp.com/support

Before contacting HP, collect the following information:

• Product model names and numbers

• Technical support registration number (if applicable)

• Product serial numbers

• Error messages

• Operating system type and revision level

• Detailed questions

Subscription service
HP recommends that you register your product for HP Support Alerts at:

http://www.hp.com/go/e-updates

After registering, you will receive e-mail notification of product enhancements, new driver versions,
firmware updates, and other product resources.

HP Insight Remote Support
HP strongly recommends that you register your device for remote support to enable enhanced
delivery of your HP Warranty, HP Care Pack Service, or HP contractual support agreement. HP
Insight Remote Support supplements your monitoring continuously to ensure maximum system
availability by providing intelligent event diagnosis, and automatic, secure submission of hardware
event notifications to HP, which will initiate a fast and accurate resolution, based on your product’s
service level. Notifications can be sent to your authorized HP Channel Partner for onsite service,
if configured and available in your country.
HP Insight Remote Support is available as part of your HP Warranty, HP Care Pack Service, or HP
contractual support agreement. For more information, see the product documentation on the HP
website (http://www.hp.com/go/insightremotesupport/docs).

Contacting HP 29

http://www.hp.com/support
http://www.hp.com/go/e-updates
http://www.hp.com/go/insightremotesupport/docs


Related information
You can find related documents on the product manuals page:

http://www.hp.com/support/StoreVirtualManuals

You can also find related documents on the Storage Information Library:
http://www.hp.com/go/storage/docs

HP websites
For additional information, see the following HP websites:

• http://www.hp.com

• http://www.hp.com/go/storage

• http://www.hp.com/service_locator

• http://www.hp.com/go/StoreVirtualDownloads

• http://www.hp.com/go/storevirtualcompatibility

• http://www.hp.com/storage/whitepapers
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7 Documentation feedback
HP is committed to providing documentation that meets your needs. To help us improve the
documentation, send any errors, suggestions, or comments to Documentation Feedback
(docsfeedback@hp.com). Include the document title and part number, version number, or the URL
when submitting your feedback.
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